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Abstract

KFormula is used to layout formulas.
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Chapter 1

Introduction

KFormula is used to write formulas. It doesn’t evaluate anything. All it does
is print them.

KFormula was designed for your editing pleasure. It makes it delightful to
enter Greek letters, fractions and all the stuff that makes a formula look like a
formula.

But most of the time you won’t want to use KFormula itself. Instead you might
choose to use it from within KWord or any other KOffice application. That is
KFormula is not a useful application on its own but an extension to all the other
KOffice applications you've fallen in love with.

Where ever KFormula gets embedded, it will behave the same.
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Chapter 2

Basics

A new (empty) KFormula document looks like a small blue square. This square
stands for the central idea of KFormula. It represents an empty list. The idea
of KFormula is to have different elements arranged in lists. An element in this
respect might be a single char or a root symbol or something like that. The lists
are put together so that they form a formula. That is there are lists for indexes,
lower and upper bounds and so on. And of course there is the main list, which
we’ve already seen.

Writing a formula means to fill the empty list with letters, figures and mathe-
matical symbols. That is straightforward: use your keyboard. As soon as you
type something the ‘empty” symbol will vanish and you will see whatever you
have inserted instead. New characters are always put at the current cursor
position.

There is a toolbar called Add that allows you to create more complex elements.
There are indices, fractions, roots and matrices to name a few. All these ele-
ments consist of at least one list, you can move the cursor into and insert new
items.
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Chapter 3

Using KFormula

Below is a typical formula entry in KFormula. To enter the partial derivatives
and Greek letters click on the symbol combo box, on the right, and select the
appropriate symbol. The symbol combo box, in the figure below, has the word
‘Cap’ on it. Click on the return key symbol to the right of it, to enter a symbol.

/home/annmajgreen.kfo - KFormula

File Edit Element Settings Help

Y E=mel «y 4 D
w%@m%mthznﬁﬁ%ﬁ
(s [o) (8) (1) [[womal [+] “[wps PETER

[ Juv’s -ovAwxdydz = [[# 2 .6 2¥ ag

The Greens formula above can be printed to a PostScript® file. To do that
choose File — Print and configure print as shown below:
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Print - KFormula o o ¢
—Frinter

Name: [ dPrintto File (PostScrint) v]

State: ldle {accepting jobs) [ Preview

Type: Wirite PostScript file -

Location:  Laocal file
Comment:

Qutput file: [Ihnmefannmafgreen.ps l

[ Qptions == [ System Oplions H Help l [ Erint ] [ Cancel l

Here is what the resulting PostScript®) file should look like:

V40 - OVZy dxdydz = a¢ ds
K yxdydz= [ [ag-

3.1 More KFormula features

More on formulas

To enter matrices, click on the [ ] and then click on the matrix symbol .
. You can move from matrix element to matrix element using the arrow keys
Right arrow, Up arrow, Down arrow and Left arrow. An example matrix is
shown below.

123

456
/89
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Chapter 4

Command Reference

4.1 The Main KFormula Window

4.1.1 The File Menu

File — New (Ctrl+N) Creates a new KFormula document.

File — Open... (Ctrl+O) Opens a previously saved document.
File — Open Recent Displays a selection of recently opened documents.

File — Save (Ctrl+S) Saves the document.

File — Save As... Saves the document with a name you provide.
File — Reload Reloads the more recently opened document.
File — Import Imports formulas from other formats.

File — Export Exports the current document in another format.

File — Mail... Invokes KMail so you can email the file. The file is already at-
tached to the email.

File — Print... (Ctrl+P) Prints the document.

File — Print Preview... Shows how the printed document will appear.

File — Document Information Provides a dialog box where you can enter your
name, email address and a short description about the document.

File — Close (Ctrl+W) Closes the current document.

File — Quit (Ctrl+Q) Quits KFormula.
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4.1.2 The Edit Menu

Edit — Undo (Ctrl+Z) Undoes an action. You can revert to the state that ex-
isted before your last change.

Edit — Redo (Ctrl+Shift+Z) Undoes an undo. Reverse the action of Undo.
This will restore the change you originally made.

Edit — Cut (Ctrl+X) Cuts a highlighted piece of text from the KFormula screen.

Edit — Copy (Ctrl+C) Copies a highlighted piece of text from the KFormula
screen.

Edit — Paste (Ctrl+V) Pastes the text you selected with Cut or Copy to the
KFormula screen.

Edit — Select All (Ctrl+A) Highlights all the text in the KFormula screen for
either Cut or Copy.

Edit — Remove Enclosing Element (Ctrl+R) Removes enclosing braces, brack-
ets or absolute value bars. This action takes place on the braces just out-
side the cursor.

Edit — Convert to Greek (Ctrl+G) Converts a Latin character to a Greek sym-
bol.

Edit — Edit Formula String... Brings up an editor where you can edit the ex-
isting formula.

See the Advanced editing section for details.

41.3 The Element Menu

Element — Add — Add Root Inserts the square root.

Element — Add — Add Fraction Inserts a fraction.

Element — Add — Add Bracket Inserts a pair of brackets, i.e. (). You can also
just type ( to insert a pair of brackets.

Element — Add — Add Integral Inserts the integral sign.
Element — Add — Add Sum Inserts the summation sign. (sigma).
Element — Add — Add Product Inserts the product sign.

Element — Add — Add Matrix... Inserts a matrix. A dialog box pops up, with
the default size being 3x3. You can specify the number of rows and
columns in this box.

Element — Add — Add 1x2 Matrix Inserts a two rowed column vector.
Element — Add — Add Overline Inserts an overline in this box.

Element — Add — Add Underline Inserts an underline in this box.
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Element — Add — Add Multiline Inserts a new line each time you type Enter
in the square.

Element — Add — Add Upper Index (Ctrl+U) Adds an upper index like so:
M
Ya
i
23

Element — Add — Add Lower Index (Ctrl+L) Adds a lower index: =1 !

NOTE
See the Definite Integrals and Indices section for details about indices.

Element — Add — Add Negative Thin Space Inserts a small reduced space,

here between the o and the e:

Element — Add — Add Thin Space Inserts a small space.

Element — Add — Add Medium Space Inserts a space that is one and a half
times wider.

Element — Add — Add Thick Space Inserts a double space.
Element — Add — Add Quad Space Inserts a quadruple wide space.

Element — Matrix — Insert Column Inserts a column in an existing matrix.
The column is inserted where the cursor is at.

Element — Matrix — Append Column Appends a column to an existing ma-
trix. The column is appended on the right.

Element — Matrix — Remove Column Removes a column from an existing
matrix. Removal occurs where the cursor is positioned.

Element — Matrix — Insert Row Inserts a row in an existing matrix. The row
is inserted where the cursor is at.

Element — Matrix — Append Row Appends a row to an existing matrix. The
row is appended on the bottom.

Element — Matrix — Remove Row Removes a row from an existing matrix.
Removal occurs where the cursor is positioned.

Element — Size Allows to set the size of the font (from 6 to 72).

Element — Left Delimiter Allows insertion of various delimiters i.e. (, {, and

[.

Element — Right Delimiter Allows insertion of various delimitersi.e. ), }, and

I

Element — Insert Symbol (Ctrl+I) Inserts the symbol, selected in the symbol
toolbar.
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4.1.4 The Settings Menu

Here you can choose how KFormula is configured. You can select the toolbars
you want displayed or the type of fonts to be used.

Settings — Toolbars — File (KFormula) Toggles the toolbar that contains click-
able icons for new, open and save files. Print and print preview are here
also.

Settings — Toolbars — Edit (KFormula) Toggles the edit toolbar. Here are click-
able icons for cut and paste as well as Undo and Redo.

Settings — Toolbars — Add (KFormula) This toolbar contains all the mathe-
matical elements such as Sum, Integral, Exponent etc.

Settings — Toolbars — Font (KFormula) This toolbar contains the font settings
(size, bold, italic, etc.).

Settings — Toolbars — Symbol (KFormula) This toggles the combo box that
contains Del, the partial derivative symbol, limit arrows, boolean opera-
tors and other mathematical symbols.

Settings — Toolbars — Matrix (KFormula) This toggles the matrix toolbar. It
contains clickable icons that pertain to matrix creation and editing.

Settings — Syntax Highlighting Checking this item determines if the num-
bers will be displayed in color.

4.1.5 Configuring Shortcuts

The Settings — Configure Shortcuts... allows you to specify shortcuts.

Below is an example of how to configure a shortcut for a print preview.
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7 Configure Shoricuts - KFommula 7 0 x

Search: |

|A|:ti0n |Sh|:|rtcut |Alternate |

[

[ Open... Ctrl+0
=iPrint... Ctrl+P
o5 Frint Preview..

L]

[©] Gwit Cirl+@
Reload

[TRemove view
Rennrt Rin

—shortcut for Selected Action

(@ None () () Custom

Default key: Mone

(5] [ coes

E1D

e Click on Custom.

e Next click on the button Advanced » and then Primary shortcut:.

e Do ctrl Space and the dialog should disappear. The shortcut is now en-
tered.

Configure Shortcut - KFormula

() Alternate shartcut,  E C]
[ ] Multi-key mode

[ Advanced ==

Pressing the keys Ctrl Space now displays the print preview.

4.1.6 Configuring Toolbars

The Settings — Configure Toolbars... is used to add additional buttons to the
toolbars.
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Configure Toolbars - KFormula 7O X
Toolhar:
| File <KOffice= |~
Available actions: Current actions:
R T B _: o

[ Open Recent

fay Open..

Save
Feload ﬂ' Print
1 Remove View 3 Print Preview
ke 3
Fepart Bug... +» -

Show Add (KFarmula) Toolbar

Show Edit (KFarmula) Toolbar

Show File (kFarmula) Toolbar

Shaow Fant (kKFarmula) Toalbar

Show Matrix (KF ormula) Tnnle
I

[ gave As.. X
¥

Show Symbol (KFormula) Too

0 | @)
T

e To add a button to the File toolbar,

Bl A K
make sure File <KOffice> is displayed in the top combo box.

e Click on one of the items in the left hand pane. This item will now be high-
lighted to show that it has been selected.

o Next click on the Right arrow button to place it in the right pane.
e Click on Apply and then click on OK.

Bl 10

The new Item should be in the toolbar.

4.1.7 Configuring KFormula

The Settings — Configure KFormula... is where the font sizes and font styles
are selected.

10
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e The Formula section allows you to select fonts and font highlight colors.

4.1.8 The Help Menu

Help — Tip of the Day Opens the Tip of the Day dialog which displays a ran-
dom tip about KFormula.

Help — KFormula Handbook (F1) Invokes the KDE Help system starting at
the KFormula help pages. (this document).

Help — What's This? (Shift+F1) Changes the mouse cursor to a combination
arrow and question mark. Clicking on items within KFormula will open
a help window (if one exists for the particular item) explaining the item’s
function.

Help — Report Bug... Opens the Bug report dialog where you can report a
bug or request a ‘wishlist’ feature.

Help — Switch Application Language... Opens a dialog where you can edit
the Primary language and Fallback language for this application.

Help — About KFormula This will display version and author information.

Help — About KDE This displays the KDE version and other basic informa-
tion.

11
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Chapter 5

Advanced Editing

5.1 Name insertion

A special feature is the name insertion. The blue square you type into is actual
a list. Furthermore, that list can contain other lists. When you type a backslash
(\) you get a new empty list right away. But this one is special. It uses a differ-
ent font and is meant to insert things like function names. There is, however,
a second idea here. Your keyboard only has a limited number of keys. The
wealth of mathematical symbols on the other side is overwhelming. To get one
of those you can type its name and press the space bar afterwards. The name
you typed will be replaced by the symbol then. In this context, the Space bar
means ‘get out of here’, that is move the cursor to the containing list. The cur-
sor will be positioned at the end of what you just entered but will also enclose
part of the original formula, after pressing the space bar.

Another thing you might want to insert are spaces. We all know, printing for-
E;ltl’lae is all about the right spacing. And you can do just that using a ‘name
Inside the blue square do: \ , SPACE to get a small space.

Do: \ < Space to get a medium space.

Do: \ ; Space to get a thick space.

Do: \ quad Space to get a quadruple wide space.

In the same way, specific mathematical symbols can be inserted. \ oint Space
inserts the path integral about a closed contour. Below is the result of \ oint
Space:

12
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5.2 Editing Formulas

The Edit — Edit Formula String allows the user to edit the ASCII formulas that
have been copied from other applications, such as Scilab, and transform them
directly into mathematical type. An example will make this clear. Below is a
screenshot of INRIA Scilab.

zcilab-3.1,1 | =cilab-3,1,1 Scilab Congortium (Inria. Enpc)
Filel Eontroll Demosl Graphic Window O I Helpl Editorl

scilab-3.1.1

Copyright (c) 1989-Z005
Consortium Scilab (IMRIA, ENPC)

Startup execution:
loading 1nitial enwironment

——>deff (' [yl=F(x])', 'y=x*sin(30%x)/sqrt{l-((x/(2¥5pil))"2)) ")

——intg(0,2%%pi, )
ans =

- Z.54325596
__>D

Copy and paste the text beginning with x*sin (30*x) into the formula editor as
shown below:

13
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Formula String 7 0O X

SIS AT -(0 2% it 2|

1.36
[ [8]34 H Cancel l
4

If you click on OK, the editor will complain about aborted parsing. It cannot
recognize one of the symbols in the formula. The displayed formula would
show that the Pi symbol is not correctly rendered. This means that the % must
be deleted. Do this and KFormula will render the mathematical font properly,

as shown below.
S1 n(3 0 * ::{)

V-G

The formula editor will accept most C language mathematical expressions, like
the formulas from a Runge-Kutta program below:

void derives (float x, float y[], float dydx[])
{

dydx [1] = y[2];

dydx [2] = -0.8*x*y[2] - sin(x)*y[1l];

}

Here dydx[1] is the first order derivative and dydx[2] is the second order
derivative. After copying the formula, you will have to edit the derivatives
with KFormula. Here is how it is done. First copy and paste the bottom ex-
pression into the formula editor.

14
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Formula String

dhyix[2] = -0.8%[2] - singh™y[1];

Next remove the [ ], leaving just y’s.

15
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Formula String

= -0.8%% - sinfa™y]

1:24

’ ] ][ cancel ]

Now click OK and place the cursor by a y and delete it. Insert the appropriate
symbols as shown below.

.7 thomelannmairk.kfo - KFormula

File  Edit Element Settinos Help
DEEdwadl «~ 4 O
VEF@QRHEx T xjz> 87 > 2
y L] [Normal |v] [ﬂ Delta |v]£J U E e
d’ |

y —O.S*X*ﬁ-sm(x)*y

JD= dx

Not every expression that KFormula is capable of translates into a valid C ex-
pression. For example the superscript expression:

16
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KFormula [modified]

File Edit Element Settings Help

EE=msl «y 4 D
VL@l zfz X TNEF > 2
(26 [~ (8] (1] |[mormal RAENERI AN A e

H [a Delta

is displayed as () ** (), which is not a valid C statement for exponentiation.
Similarly the 1 by 2 matrix displays as () /(). This is not a valid array in C.

5.3 Definite Integrals and Indices

5.3.1 Definite Integrals

A definite integral is made by using Ctrl+U for the upper limit of integration
and Ctrl+L for the lower limit of integration.

C
sin(z) dz
0

Reposition the cursor in front of the integral after making the first of the limits.
5.3.2 Positioning Indices

The upper or lower index can be positioned by highlighting the desired text.
In this example, an arrow is needed above the P, in dP. Using Ctrl+U places the
JE

desired vector symbol in the wrong place; namely above the ‘d’. dP
i
The problem is solved by highlighting only the P in and then
—_—

entering Ctrl+U. Here is the correct result. d P

17
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Chapter 6
Credits and Licenses

KFormula Copyright by The KFormula Team
KFORMULA DEVELOPERS (ALPHABETICALLY)

o Alfredo Beaumont Sainz alfredo.beaumont@gmail.com

e Ulrich Kiittler

e Andrea Rizzi

Documentation copyright 2002 Jonathan Drews j.e.drews@att.net
Documentation copyright 2005 Anne-Marie Mahfouf annma@kde.org
Documentation copyright 2006 Alfredo Beaumont Sainz alfredo.beaumont@gmail.com

This documentation is licensed under the terms of the GNU Free Documenta-
tion License.

This program is licensed under the terms of the GNU General Public License.

18
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Appendix A

Installation

A.1 How to obtain KFormula

KFormula is part of the KDE project http:/ /www.kde.org/ .

KFormula can be found in the koffice package on ftp://ftp.kde.org/pub/-
kde/ , the main FTP site of the KDE project.

A.2 Requirements

KFormula is part of KOffice on The KFormula home page You must have KOf-
fice installed. KFormula will not work without the rest of KOffice

A.3 Compilation and Installation

For detailed information on how to compile and install KDE applications see
Building KDE4 From Source

Since KDE uses cmake you should have no trouble compiling it. Should you
run into problems please report them to the KDE mailing lists.

19
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